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Overview 

Intended Use (RUO) 

This technical user guide is for PANDAA® Ebola, a Research Use Only (RUO) real-time RT-PCR assay 
for the amplification and qualitative pan-species detection of orthoebolavirus RNA. PANDAA Ebola is 
uniquely designed to provide accurate and rapid information for the identification of ebolaviruses, and 

PANDAA VHF Interpretation Software may be used to support analysis and interpretation of results. 
Use the most current version of this Instructions for Use available at www.aldatu.bio/downloads. 

This kit is for Research Use Only and is not intended for use in diagnostic procedures.  

PANDAA Ebola Test Principle 

PANDAA Ebola assay is comprised of single reaction mix containing PANDAA primers to amplify and a 
FAM-labelled hydrolysis probe to detect all known species of ebolavirus.  

An exogenous, non-competitive internal control is included to monitor for successful nucleic acid 
extraction and for the presence of RT-PCR inhibitors. A sample adequacy control (SAC) detects 

endogenous human RNase P in samples derived from human biological material to control for sample 
quality and to ensure adequate addition of sample to the reaction.  

The entire PANDAA Ebola workflow can be completed in two hours.  
cAssay preparation takes ~30 minutes with a 
PCR run time ~70 minutes. Prepare the 
PANDAA mastermix by adding Stop-Start RT 
enzyme and PANDAA to the PRxB buffer. 

Dispense 10 µL of mastermix into each PCR 
well/tube, then add sample RNA to each 
well/tube. No mixing is necessary.  

Compatible Real-Time PCR Instruments 

Any real-time PCR instrument that can detect fluorophores in the green, yellow, and red channels, such 
as those listed in Appendix B. 

PANDAA Technology 

Aldatu Biosciences’ detection and genotyping PANDAA technology uniquely compensates for evolving 
pathogen diversity, ensuring that PCR diagnostic integrity isn’t affected by genomic variation now, or in 
the future. PANDAA is designed to mitigate genomic variability by normalizing probe-binding regions. 

During the initial real-time PCR cycles, the target genome is adapted through site-directed mutagenesis 
to replace any polymorphisms that could cause false negative results. Read the methods publication 
here: https://www.nature.com/articles/s42003-021-01751-9. 
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Contents and Storage 

Reagents  

The kit includes all amplification reagents for 96 reactions and includes one (1) each of the Positive 
Control, Negative Control, and Internal Control RNA. Refer to Appendix A for a list of materials 
required but not included. 

Contents Cap color Top Label Quantity Volume 

PRxB III Buffer Clear PRxB 2 500 µL 

Ebolavirus PANDAA White PAN EBOV 2 35 µL 

Stop-Start RT Enzyme Blue RT 1 8 µL 

Internal Control RNA Yellow  INT CTRL 1 120 µL 

EBOV Positive Control Red POS 1 100 µL 

Negative Control Green NEG 1 100 µL 

 

Storage and Stability 

PANDAA Ebola is shipped on dry ice, and kit components arrive frozen. Store all components at −15 °C 

to −25 °C upon receipt, protected from light. Stop-Start RT enzyme contains glycerol and may remain 

liquid at −15 °C to −25 °C. Keep reagents in the original packaging when not in use and return them 

promptly to recommended storage conditions. For receiving inspection and handling, see General 
Guidelines → Shipping, Storage and Handling (page 25). 

A unique feature of PANDAA assays is that, after thawing, all components except Stop-Start RT 
enzyme may be stored at 2 °C to 8 °C for up to 7 days, protected from light. To maintain assay 
performance, avoid more than two freeze-thaw cycles for any reagent.  

Contents Stability at 2 °C to 8 °C 

PRxB III Buffer 

7 days 

Ebolavirus PANDAA 

Internal Control RNA 

EBOV Positive Control 

Negative Control 

Stop-Start RT Enzyme Should only be stored at −15 °C to −25 °C 

 NOTE: All reagents, other than the Stop-Start RT enzyme, may be stored  
at 2 °C to 8 °C for up to one week after thawing. 
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Reagents Description 

PANDAA Reaction Buffer (PRxB III) 

A complete custom assay buffer that is compatible with high, low and no ROX real-time PCR machines. 
Contact Technical Support (support@aldatubio.com) with questions about your real-time PCR 

instrument requirements and configuration. 

Stop-Start RT Enzyme 

A specially formulated hot-start reverse transcriptase optimized for PANDAA. 

Ebolavirus PANDAA 

Includes uniquely designed PANDAA primers and probes for the amplification and detection of three 

distinct targets:  

 Ebolavirus (PAN EBOV): targeted to the nucleoprotein (NP) region of the ebolavirus genome.  

 Internal Control (IC): detects the internal control RNA, which serves as a process control for 
both RNA extraction and PCR amplification. 

 Sample Adequacy Control (SAC): detects human 

  RNase P in samples derived from human biological material to control for the quantity, quality 
and adequacy of the specimen. 

Extraction and Amplification Controls 

 Internal Control (IC) is an exogenous, non-competitive control that detects MS2 phage-specific 
RNA, which should be either spiked into the lysis buffer prior to extraction or added directly to 
the real-time PCR reaction mix.  

 EBOV Positive Control consists of synthetic, non-infectious RNA covering the assay target 
regions in the genome of Ebola virus, isolate Mayinga, species Orthoebolavirus zairense. The 
control is provided at 150 copies/µL to yield 1,500 copies/reaction when using 10 µL control per 
reaction. It is prepared in a background of human genomic DNA and Internal Control RNA. 

 Negative Control comprises ~0.1 ng/µL human genomic DNA, which is ~30 copies/µL to yield 
~300 copies/reaction when using 10 µL control per reaction, and includes Internal Control RNA. 
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Sample Preparation for PANDAA Ebola  

The starting material for the PANDAA Ebola kit is isolated viral RNA. Read the Safety section. If samples 
have already been extracted then proceed to PANDAA Ebola Kit Step-by-Step Instructions on page 9. 

Nucleic Acid Extraction 

Compatible Extraction Reagents 

Many commercially available nucleic acid extraction systems are compatible with real-time PCR and 
are suitable for sample preparation prior to PANDAA Ebola testing, including systems that purify total 
nucleic acid (DNA and RNA). Follow the extraction kit manufacturer’s instructions for the nucleic acid 
extraction kit or workflow used for viral RNA and refer to the safety guidelines in this user guide. 

Sample Volume 

The recommended sample input volume for nucleic acid extraction is 140 µL. Sample input volume may 
vary by platform and should be maximized to optimize test sensitivity.  

Recommended specimen type EDTA plasma 

Recommended sample volume 140 µL 

Recommended elution volume 60 µL 

Required Elution Volume 

Elution volume may vary by nucleic acid extraction protocol and should be optimized to maximize RNA 
recovery while minimizing dilution. Typical elution volumes range from 50 µL to 100 µL. Each PANDAA 
Ebola reaction requires 10 µL eluted RNA. 

Extracted RNA Handling 

Use extracted RNA as soon as possible after extraction. If testing is delayed, extracted RNA may be 

stored at 2 – 8 °C for up to 6 hours. Extraction eluants and storage conditions can affect RNA stability, 
which may reduce detection in low-copy-number samples. 

Internal Control for RNA Extraction 

The Internal Control (IC) RNA provided can be added to the sample extraction kit lysis buffer to serve 
as a full process control and verify successful RNA extraction as well as downstream 
amplification/detection. For each sample being processed, add 1 µL IC to the sample extraction lysis 
buffer e.g., if processing 48 samples then add 48 µL IC to the lysis buffer.  
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PANDAA Ebola Kit Step-by-Step Instructions 

A. Before Beginning 

PANDAA Ebola is a highly sensitive molecular assay. To prevent false-positive results, follow a strict 
unidirectional workflow. Always use separate, dedicated lab areas and equipment for reagent 
preparation and for sample/control addition. 

 ❚❛❜ 
CAUTION 

In a dedicated lab area for setting up PCR reaction mixes 

Remove reagents from storage and place at room temperature to thaw. Estimated 
thawing times are 10 minutes for PRxB buffer and 5 minutes for PANDAA tubes. 

Remove Stop-Start RT enzyme (RT) from the freezer and place it directly on ice. 
Tubes should be placed on ice after thawing. 

B. PANDAA Ebola Mastermix Setup (48 Reactions) 

1. Prepare reagents: Spin the reagent tubes briefly to collect drops on the interior sides of the tubes. 
Gently vortex the reagent tubes and spin briefly again. 

2. Add reagents to PRxB tube: 

 Add 30 µL Ebolavirus PANDAA directly to the PRxB tube. 

 Add 3 µL Stop-Start RT enzyme directly to the PRxB tube.  

2..1 Submerge only the tip of the pipette to ensure that no excess RT droplets are transferred 
to the exterior of the tip. 

 If Internal Control (IC) was not added to the lysis buffer prior to sample extraction, it should 
be added to the PRxB tube here. 

 For 48 samples, add 3 µL Internal Control (IC) to the PRxB tube if the IC was not added to 
the lysis buffer prior to sample extraction. 

3. Mix reagents: Gently vortex the PRxB tube containing the Stop-Start RT enzyme, PANDAA, and 

Internal Control (if not added to the sample extraction lysis buffer). Spin to collect any droplets. 

NOTE: 24 reactions modification 

Remove 250 µL PRxB buffer and transfer to a clean tube. Add 15 µL Ebolavirus 
PANDAA and 1.5 µL Stop-Start RT Enzyme. Add 1.5 µL IC RNA only if the IC 
was not added to the lysis buffer. 

Follow the storage instructions on page 6 for the remaining reagents. 
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C. Real-time PCR Plate Setup  

1. Dispense mastermix: Add 10 µL of the complete mastermix from the PRxB tube into each 
required well of an optical 96-well reaction plate or to each optical reaction tube compatible with 

your real-time PCR instrument. 

 ❚❛❜ 
CAUTION 

Perform the remaining steps in a pre-amplification area 
designated for RNA handling in your laboratory 

 

2. Add sample or controls: Add 10 µL sample RNA, Positive Control, or Negative Control into the 
top of the mastermix in each well / tube. Do not pipette up and down to mix. 

3. Seal and spin (plate only): Seal the plate with optical adhesive film or cap the reaction tubes. If 
using a 96-well plate, spin the plate briefly before loading into the real-time PCR instrument.  

 

D. Real-time PCR Protocol 

1. Proceed immediately to loading the plate / tubes into the real-time PCR instrument. 

2. Use the real-time PCR template provided by Aldatu Biosciences, which can be downloaded from 
www.aldatu.bio/qpcr-templates. Total run time should be 60 to 80 minutes. 

  

NOTE: Fewer than 48 reactions 

If you require fewer than 48 reactions, prepare mastermix for 48 samples and 
store any unused volume. The complete PANDAA Ebola mastermix (PRxB, Stop-
Start RT enzyme, and PANDAA (with or without Internal Control) is stable for up 
to 48 hours when stored at 2–8 °C. 
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E. Manual Real-time PCR Settings 

Use the real-time PCR run template provided by Aldatu Biosciences, available at www.aldatu.bio/qpcr-

templates. Aldatu Biosciences cannot accept any responsibility for inaccurate data that has been 
generated through incorrect manual programming of the real-time PCR instrument.  

Use the following parameters and proceed to run the PANDAA real-time PCR. Refer to Appendix B 
(page 28) for detection channel settings for compatible real-time PCR instruments. For assistance 
with instrument configuration, contact Aldatu Biosciences Technical Support (support@aldatubio.com). 

Real-Time PCR Instrument Settings 

Setting Value 

Reaction volume 20 µL 

Ramp rate Fast, if compatible with your real-time PCR instrument. Otherwise use 
standard ramp rates. Refer to page 17 for ramp temperatures. 

Passive reference (if applicable) ROX 

 

Target Name Ex / Em (nm) Channel Reporter 

Ebolavirus (PAN EBOV) 495 / 520 Blue/Green* 
Refer to Appendix B (page 28) 
for instrument-specific reporter / 
dye settings. 

Internal Control (IC) 650 / 670 Red 

Sample Adequacy Control (SAC) 554 / 576 Yellow 

*Channel name may differ between instruments. 

Cycling Conditions 

During the 60 °C anneal and extension phase of the Amplification and Detection step, acquire 
fluorescence data in the green, yellow, and red channels. 

Step Temperature Time Cycles 

Reverse transcription 50 °C 15 minutes 1 

Enzyme activation 95 °C 2 minutes 1 

PANDAA adaptation 

95 °C 

55 °C 

60 °C 

1 second 

30 seconds 

30 seconds 

10 

Amplification and detection 
95 °C 

60 °C 

1 second 

(acquire) 60 seconds 
35 
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PANDAA EBOV Qualification Panel  

 

PANDAA Ebola Kit Quick Guide 

  

NOTE: PANDAA EBOV Qualification Panel 

For first-time instrument use, perform a preliminary run with the PANDAA EBOV 
Qualification Panel (catalog #4111096), provided free with any Aldatu assay 
order. The panel contains ten synthetic, non-infectious RNA samples: nine positive 
controls covering all five ebolavirus species and one negative control (Marburg 
virus). Contact support@aldatubio.com for details. 
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Data Analysis and Interpretation of Results 

Real-Time PCR Analysis Parameters 

Refer to Appendix B (page 28) for instrument-specific analysis settings, including threshold settings for 
determination of Ct values for the ebolavirus, Internal Control, and Sample Adequacy Control targets. 
For technical assistance, contact Aldatu Biosciences at support@aldatubio.com. 

 

Threshold Settings 

Adjust the EBOV threshold following the instrument-specific analysis settings in Appendix B (page 28). 
Use the instrument’s automatic threshold for IC and SAC (recommended). If set manually, place the IC 

and SAC thresholds in the exponential (log-linear) region above baseline and below plateau; apply the 
same setting to all samples and controls. 

 

Fluorescence Cutoff  

Minor non-specific increases in fluorescence due to probe hydrolysis, dye crosstalk, or signal drift can 
produce spurious Ct values in the absence of genuine target amplification. The fluorescence cutoff 
distinguishes these artefactual signals from true positive results. 

At the end of the PCR run, a fluorescence cutoff of 2% should be applied to confirm negative results. 
A well is called negative if its baseline-subtracted endpoint fluorescence (ΔRn on Applied Biosystems 
and Thermo Fisher instruments; baseline-subtracted endpoint RFU on Bio-Rad CFX instruments; 
fluorescence change on Qiagen Rotor-Gene and Mic instruments) is less than 2% of the highest 
baseline-subtracted endpoint fluorescence detected on the plate. The highest value on the plate is 

typically the on-plate Positive Control. Refer to Appendix B (page 28) for instrument-specific 
instructions. The fluorescence cutoff is determined automatically when using the PANDAA VHF 
Interpretation Software. 
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PANDAA VHF Interpretation Software 

PANDAA VHF Interpretation Software is a free, automated tool for reviewing and interpreting Aldatu 

PANDAA real-time PCR run files for viral hemorrhagic fever assays. The software can import data 
directly from instrument files generated by supported real-time PCR instruments, apply standardized 
analysis thresholds, evaluate control validity, and generate summary reports, typically in a few seconds 
after importing a run file. Refer to the PANDAA VHF Interpretation Software instructions for use for 
installation, supported instruments, and detailed operating instructions.  

Download the PANDAA VHF Interpretation Software from www.aldatu.bio/vhf-software. 

Key Capabilities 

 Automatically analyzes results directly from instrument data files from multiple real-time PCR 
instrument platforms. 

 Applies standardized analysis criteria (Ct and fluorescence cutoff thresholds). 

 Validates quality controls with a structured flag framework. 

 Generates formatted reports (PDF and Excel) for documentation and review. 

 Provides "Detected/Not Detected" interpretations with appropriate validity flags. 

Supported Instruments and File Types 

The software can currently accept the analyzed instrument run file directly from multiple instruments 
and accepts results files from the following real-time PCR instruments in the formats below. 

 

Instrument Supported File Formats 

QuantStudio 5 .eds, .xlsx 

QuantStudio 7 Pro .eds, .xlsx 

7500 / 7500 Fast .eds, .xls 

Rotor-Gene Q .rex, .csv 

Mic .micrun, .xlsx 

CFX96 .pcrd, .xlsx 

LightCycler 96 .lc96, .txt 

LightCycler 480 II .ixo, .txt 
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Positive and Negative Controls Interpretation 

These PCR controls must be included in every run for the results to be valid. The Positive Control must 

have a Ct < 30 cycles for the PAN EBOV target to pass quality control; the PAN EBOV target must not 
be detected in the Negative Control. 

 

Control Target Call Results Interpretation 

POS 

PAN EBOV + 

PASS 
Positive Control passed QC as the EBOV Ct is below the cut-
off. 

IC + 

SAC + 

POS 

PAN EBOV - 

FAIL 
Positive Control failed QC as the EBOV Ct is above the cut-off.  

This may indicate an error during setup, inefficient sample 
extraction or amplification reagent issues. 

IC + 

SAC + 

NEG 

PAN EBOV - 

PASS 
Negative Control passed QC as the EBOV Ct is above the cut-
off. 

IC + 

SAC + 

NEG 

PAN EBOV + 

FAIL 
Negative Control failed QC as the EBOV Ct is below the cut-
off. This may indicate an error during setup or cross-
contamination. 

IC + 

SAC + 
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Results Interpretation 

A Ct value < 30 cycles for the ebolavirus (PAN EBOV) target indicates that ebolavirus RNA is present 

in the sample. If the PAN EBOV target is ≥ 30 cycles, or not detected, and the Internal Control Ct value 

is < 30 cycles then ebolavirus RNA is not present.  

If both the PAN EBOV and Internal control Ct is ≥ 30 cycles, or not detected, then there has been a 

reagent or extraction failure and the sample should be repeated.  

PAN EBOV IC SAC Call Results Interpretation / Recommended Action 

+ ±* ±* Positive 
Ebolavirus RNA detected. Detection of IC or SAC is 
not required for a positive result. 

- + + Negative 
Ebolavirus RNA not detected; successful RNA 
extraction and sample adequacy verified. 

- + - Invalid Result 

SAC not detected; inadequate human biological 
material, inappropriate specimen collection, or 
compromised specimen integrity. Repeat extraction 
and/or obtain a new specimen. 

- - + Invalid Result 
Internal control not detected; indicates a potential 
reagent or extraction failure. Repeat extraction 
and/or obtain a new specimen. 

- + N/A† Negative 
Ebolavirus RNA not detected; successful RNA 
extraction verified. Sample adequacy control is not 
applicable for non-human biological specimens. 

- - N/A† Invalid Result 
Internal control not detected; indicates potential 
reagent or extraction failure. Repeat extraction 
and/or obtain a new specimen. 

±*: Detection of Internal Control (IC) and Sample Adequacy Control (SAC) is not required to interpret a positive result for 

Ebolavirus, as high viral load can suppress these signals. 

N/A†: SAC is not applicable when testing samples that are not derived from human biological material. In these cases, only 

the Internal Control is required for result interpretation. 

* Internal Control and Sample Adequacy Control Interpretation 

PANDAA Ebola contains an exogenous, non-competitive extraction control (Internal Control) that is 
either spiked into the lysis buffer prior to extraction or added directly to the PRxB buffer. Additionally, 
PANDAA Ebola contains amplification and detection reagents for the Sample Adequacy Control (SAC), 
which detects human nucleic acid. A high ebolavirus viral load may lead to the biased consumption of 
reaction amplification components and cause a delayed or absent Internal Control signal and/or Sample 

Adequacy Control signal. Therefore, detection of the Internal Control or Sample Adequacy Control is 
not required to call a positive result for ebolavirus.  
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Performance Characteristics 

Analytical Sensitivity (inactivated virus, PFU/mL) 

The limit of detection (LoD) of PANDAA Ebola was estimated using gamma-irradiated cell lysate and 
supernatant from Vero E6 cells infected with Bundibugyo ebolavirus, Sudan ebolavirus, or Zaire 
ebolavirus obtained from the Biodefense and Emerging Infections Research Resources Repository (BEI 

Resources). Analytical sensitivity was defined as the concentration (plaque forming units (PFU) per ml) 
detected with a positivity rate of ≥ 95% for Sudan ebolavirus and Zaire ebolavirus. For Bundibugyo 
ebolavirus, the 95% limit of detection was determined by probit. 

Virus isolate tested Common name Limit of Detection 

Bundibugyo virus, Butalya-811250 Bundibugyo ebolavirus (BDBV) 5.7 PFU/mL 

Sudan virus, Boniface Sudan ebolavirus (SUDV) 200 PFU/mL 

Ebola virus, Makona Zaire ebolavirus (EBOV/ZEBOV) 50 PFU/mL 

Tentative Limit of Detection (LoD) Estimation 

For the tentative LoD estimation, inactivated virus was spiked into pooled EDTA plasma from 
1,000 PFU/mL to 1 PFU/mL in half-log dilutions, or with PBS as the extraction negative control. Nucleic 
acid was extracted from 140 µL sample using the QIAamp Viral RNA Mini Kit (Qiagen). For each 
concentration, 3 independent extractions were performed and a single replicate per extraction was 
used with the PANDAA Ebola assay on the ABI 7500 Fast (ABI 7500), Mic real-time PCR Cycler (Mic), 

and QuantStudio 5 (0.1 mL, 96-well; QS5). The tentative LoD estimation was refined at two chosen 
concentrations.  

Limit of Detection (LoD) Confirmation 

Based on the results obtained from the tentative LoD of Bundibugyo ebolavirus, Sudan ebolavirus, or 
Zaire ebolavirus, 20 individually spiked plasma samples were extracted  from 140 µL sample using the 
QIAamp Viral RNA Mini Kit (Qiagen). A single replicate per extraction was used with the PANDAA Ebola 
assay on the ABI 7500, Mic, QS5, and the Qiagen Rotor-Gene Q 5-Plex (RGQ). An equal number of 
negative extraction controls were performed and specificity was 100%. 

Instrument Run Time (average) Software Used 

ABI 7500 Fast: 78 min 7500/7500 Fast Real-Time PCR System Software v2.3 

Mic Fast: 87 min micPCR Software v2.12.7 

QS5 * Fast: 75 min QuantStudio Design & Analysis Software version 1.6.1 

RGQ Standard: 100 min Rotor-Gene Q Software version 2.3.5 

* Fast thermal ramp rates on the QuantStudio 5 were 4.1 °C/s (heating) and 3.1 °C/s (cooling). 
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Bundibugyo ebolavirus, Butalya-811250 

Serial dilutions were performed with irradiated infected cell lysate and supernatant from Vero E6 cells 

infected with Bundibugyo ebolavirus, Prototype Isolate #811250 (BEI Resources, NR-49813) with a pre-
irradiation titer by plaque assay of 7.9 × 106 PFU/mL. 

Limit of detection confirmation (5 PFU/mL, Bundibugyo ebolavirus) 

  

Conc. (PFU/mL) ABI 7500 Mic QS5 

1,000 3/3 3/3 3/3 

500 3/3 3/3 3/3 

100 3/3 3/3 3/3 

50 3/3 3/3 3/3 

10 2/3 3/3 3/3 

5 1/3 3/3 3/3 

1 0/3 1/3 2/3 

Negative 0/3 0/3 0/3 
 

Conc. (PFU/mL) ABI 7500 Mic QS5 

4 1/3 0/3 1/3 

2 1/3 0/3 0/3 

 

Replicate ABI 7500 Ct Mic Ct QS5 Ct RGQ Ct 

1 26.7 26.4 26.4 29.3 

2 26.0 26.4 28.2 26.2 

3 N.D. 26.9 N.D. 28.8 

4 28.4 27.0 29.2 28.3 

5 28.2 26.0 28.8 27.9 

6 27.5 26.7 27.2 28.4 

7 28.5 26.3 N.D. 26.6 

8 26.8 26.4 28.6 29.2 

9 27.3 N.D. 28.9 N.D. 

10 27.9 26.4 27.5 27.2 

11 N.D. N.D. 28.7 N.D. 

12 28.6 28.5 26.4 29.2 

13 27.8 N.D. N.D. 28.0 

14 26.7 26.7 26.4 N.D. 

15 28.5 27.1 26.2 26.8 

16 26.1 28.1 27.5 28.0 

17 28.6 N.D. N.D. 30.0 

18 27.8 27.6 27.4 28.0 

19 N.D. 30.1 28.4 29.6 

20 28.9 29.1 29.6 29.3 

Hit Rate 17/20 17/20 16/20 17/20 
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Limit of detection confirmation (10 PFU/mL, Bundibugyo ebolavirus) 

The 95% limit of detection of the PANDAA Ebola assay for Bundibugyo ebolavirus, Butalya-811250 
is 5.7 PFU/mL (95% CI: 5.1 – 11.2 PFU/mL), as determined by probit. 

  

Replicate ABI 7500 Ct Mic Ct QS5 Ct RGQ Ct 

1 26.9 27.8 25.8 27.8 

2 27.8 26.7 26.5 27.8 

3 26.2 26.0 26.5 25.5 

4 26.2 26.3 25.7 26.0 

5 25.4 26.8 25.8 26.1 

6 26.4 28.1 26.4 26.0 

7 26.7 26.5 26.6 26.2 

8 27.1 28.6 27.5 27.2 

9 26.2 26.8 26.2 26.7 

10 27.7 28.1 27.8 27.7 

11 28.3 27.6 28.7 26.2 

12 25.8 27.1 26.3 27.1 

13 27.5 26.5 26.3 26.4 

14 26.5 27.0 26.8 N.D. 

15 27.3 N.D. 29.4 27.8 

16 27.6 27.0 27.4 27.8 

17 27.7 27.7 27.3 27.6 

18 28.6 29.5 28.7 28.4 

19 26.4 26.9 26.7 28.1 

20 27.9 28.7 29.1 28.1 

Hit Rate 20/20 19/20 20/20 19/20 
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Sudan ebolavirus, Boniface 

Serial dilutions were performed with irradiated infected cell lysate and supernatant from Vero E6 cells 

infected with Sudan ebolavirus, Boniface (BEI Resources, NR-49810) with a pre-irradiation titer by 
plaque assay of 6.3 × 106 PFU/mL. The 95% limit of detection of the PANDAA Ebola assay for Sudan 
ebolavirus, Boniface is 200 PFU/mL, based on the lowest concentration at which ≥ 95% were positive. 

Limit of detection confirmation (200 PFU/mL, Sudan ebolavirus) 

Conc. (PFU/mL) ABI 7500 Mic QS5 

1,000 3/3 3/3 3/3 

500 3/3 3/3 3/3 

100 1/3 3/3 3/3 

50 1/3 0/3 1/3 

10 1/3 1/3 0/3 

5 0/3 0/3 0/3 

1 0/3 0/3 1/3 

Negative 0/3 0/3 0/3 
 

Conc. (PFU/mL) ABI 7500 Mic QS5 

200 3/3 3/3 3/3 

100 1/3 1/3 0/3 

 

Replicate ABI 7500 Ct Mic Ct QS5 Ct RGQ Ct 

1 25.9 27.2 26.3 28.0 

2 27.7 27.6 27.4 N.D. 

3 26.5 27.2 26.2 25.4 

4 27.6 28.6 26.8 24.9 

5 25.8 27.1 26.0 26.1 

6 26.6 29.4 N.D. 26.1 

7 27.0 N.D. 27.5 25.4 

8 26.5 28.0 28.2 27.6 

9 28.9 28.1 26.9 26.0 

10 27.7 29.0 28.6 25.9 

11 27.7 27.1 26.7 27.5 

12 26.6 26.5 26.1 26.4 

13 27.6 29.6 26.5 26.1 

14 26.0 26.6 26.6 25.6 

15 25.9 27.2 27.6 28.8 

16 28.7 28.0 29.7 N.D. 

17 28.6 26.4 26.7 26.1 

18 26.9 28.4 27.2 26.8 

19 27.6 29.1 27.3 29.0 

20 27.4 28.2 28.0 25.4 

Hit Rate 20/20 19/20 19/20 18/20 
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Zaire ebolavirus, Mayinga 

Serial dilutions were performed with irradiated infected cell lysate and supernatant from Vero E6 cells 

infected with Zaire ebolavirus, Mayinga (BEI Resources, NR-49809) with a pre-irradiation titer by plaque 
assay of 1.0 × 108 PFU/mL. The 95% limit of detection of the PANDAA Ebola assay for Zaire 
ebolavirus, Mayinga is 50 PFU/mL, based on the lowest concentration at which ≥ 95% were positive. 

Limit of detection confirmation (50 PFU/mL, Zaire ebolavirus) 

Conc. (PFU/mL) ABI 7500 Mic QS5 

1,000 3/3 3/3 3/3 

500 3/3 3/3 3/3 

100 3/3 3/3 3/3 

50 3/3 3/3 3/3 

10 2/3 2/3 2/3 

5 0/3 0/3 1/3 

1 0/3 0/3 0/3 

Negative 0/3 0/3 0/3 
 

Conc. (PFU/mL) ABI 7500 Mic QS5 

40 3/3 2/3 2/3 

20 1/3 1/3 1/3 

 

Replicate ABI 7500 Ct Mic Ct QS5 Ct RGQ Ct 

1 24.6 25.8 25.5 26.0 

2 26.6 25.9 25.5 26.2 

3 24.6 26.4 24.9 26.5 

4 25.8 25.8 25.2 27.8 

5 25.5 26.5 26.0 25.2 

6 26.5 25.5 25.8 25.4 

7 25.6 25.2 25.3 25.5 

8 26.4 26.0 27.0 25.2 

9 25.7 26.0 26.0 26.4 

10 27.0 26.2 27.0 25.8 

11 26.2 26.0 25.9 25.7 

12 26.5 25.1 26.1 28.6 

13 26.5 26.2 25.7 25.5 

14 24.7 25.9 24.5 25.5 

15 25.6 25.6 25.7 25.8 

16 25.6 25.9 25.5 25.9 

17 25.9 25.8 25.7 27.1 

18 26.3 27.1 26.5 25.0 

19 25.5 26.5 25.3 25.8 

20 25.8 25.4 25.9 25.6 

Hit Rate 20/20 20/20 20/20 20/20 
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Analytical Sensitivity and Inclusivity (synthetic RNA, copies/reaction) 

Analytical sensitivity and inclusivity were evaluated using in vitro transcribed RNA representing multiple 

isolates and ebolavirus species. RNA copy numbers were assigned by RT-qPCR using digital PCR 
(dPCR)-traceable calibration. Among 900 negative control replicates, analytical specificity was 99.3% 
(95% CI: 98.5% to 99.8%). 

Bundibugyo ebolavirus 

Isolate 20 copies/rxn 10 copies/rxn 5 copies/rxn 

Butalya-811250 100% (36/36) 97.2% (35/36) 75.0% (27/36) 

 

Reston ebolavirus 

Isolate 20 copies/rxn 10 copies/rxn 5 copies/rxn 

Pennsylvania 100% (36/36) 100% (36/36) 97.2% (35/36) 

R08 100% (36/36) 100% (36/36) 77.8% (28/36) 

Sudan ebolavirus 

Isolate 20 copies/rxn 10 copies/rxn 5 copies/rxn 

Boniface 100% (36/36) 100% (36/36) 97.2% (35/36) 

Gulu 100% (36/36) 100% (36/36) 86.1% (31/36) 

Maleo 100% (36/36) 100% (36/36) 69.4% (25/36) 

Nakisamata 100% (36/36) 95.7% (34/36) 83.3% (30/36) 

Uganda 100% (36/36) 97.2% (35/36) 80.6% (29/36) 

Yambio 100% (36/36) 100% (36/36) 91.7% (33/36) 

Taï Forest ebolavirus 

Isolate 20 copies/rxn 10 copies/rxn 5 copies/rxn 

Pauléoula-CI 100% (36/36) 95.8% (34/36) 45.8% (17/36) 

Zaire ebolavirus 

Isolate 20 copies/rxn 10 copies/rxn 5 copies/rxn 

Boende 100% (36/36) 100% (36/36) 100% (36/36) 

Gabon 100% (36/36) 100% (36/36) 91.7% (33/36) 

Ilembe 100% (36/36) 100% (36/36) 100% (36/36) 

Makona 100% (36/36) 100% (36/36) 94.4% (34/36) 

M-M 100% (36/36) 100% (36/36) 100% (36/36) 

Yambuku 100% (36/36) 100% (36/36) 100% (36/36) 
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Analytical Specificity (Exclusivity) 

A panel of 29 pathogens was evaluated, representing genetically related filoviruses, including Marburg 

virus and Ravn virus, and co-endemic viral, bacterial, or parasitic agents associated with febrile illness. 

Organisms were tested at high, medically relevant concentrations: viruses were tested at ≥ 105 PFU/mL 

or ≥ 105 TCID50/mL and bacteria and parasites were tested at ≥ 106 CFU/mL. Where purified nucleic 
acids was used in lieu of whole organisms, equivalent high-titer genomic copy levels were tested: viral 
nucleic acids at ≥ 107 copies/mL and bacterial/parasitic DNA at ≥ 106 copies/mL.  

The results summarized in the table below demonstrate that all tested pathogens were non-reactive 
with the PANDAA Ebola assay. 

Pathogen (Isolate) Titer Result 

Adenovirus Type 5 (Adenoid 75) 3.4 × 109 TCID50/mL Negative 

Chikungunya virus (181/25) 4.7 × 107 NDU/mL Negative 

Crimean-Congo hemorrhagic fever virus (IbAr10200) 6.3 × 106 copies/mL Negative 

Dengue virus type 1 (Hawaii) 6.2 × 105 TCID50/mL Negative 

Dengue virus type 2 (New Guinea C) 5.9 × 105 TCID50/mL Negative 

Dengue virus type 3 (Philippines/H87/1956) 9.8 × 105 TCID50/mL Negative 

Dengue virus type 4 (H241) 5.9 × 105 TCID50/mL Negative 

Hepatitis A virus (HM175/18f) 1.5 × 106 TCID50/mL Negative 

Hepatitis B virus (N/A) 2.3 × 106 IU/mL Negative 

Hepatitis C virus (N/A) 1.8 × 106 IU/mL Negative 

HIV-1 (DE00210CM019) 3.5 × 107 copies/mL Negative 

HIV-2 (subtype A, NIH-Z) 5.3 × 108 copies/mL Negative 

Human herpesvirus 4 (Epstein-Barr virus, B95-8) 1.0 × 105 copies/mL Negative 

Human herpesvirus 5 (CMV, AD-169) 1.0 × 105 copies/mL Negative 

Human herpesvirus 6 (Z29) 1.0 × 106 copies/mL Negative 

La Crosse virus (R97841d) 1.6 × 108 TCID50/mL Negative 

Lassa Fever virus (Guinea Faranah 9615289) 1.9 × 107 copies/mL Negative 

Marburg virus (Musoke) 7.6 × 105 copies/mL Negative 

Marburg virus (Voege) 8.5 × 107 copies/mL Negative 

Measles virus (MVs/Ohio.USA/17.14/3) 8.9 × 106 TCID50/mL Negative 

Mumps virus (MuV/Iowa.US/2006) 7.3 × 106 PFU/mL Negative 

Plasmodium falciparum (FCB) 8.3 × 106 copies/mL Negative 

Ravn virus (Kitum Cave-810040) 2.3 × 107 copies/mL Negative 

Rift Valley fever virus (ZH501) 1.6 × 107 copies/mL Negative 

St. Louis Encephalitis virus (V 08449) 1.6 × 106 TCID50/mL Negative 

Usutu virus (SAAR 1776) 3.5 × 106 TCID50/mL Negative 

West Nile virus (TX 9410 (D0325)) 9.8 × 106 TCID50/mL Negative 

Yellow fever virus (17D) 6.6 × 106 copies/mL Negative 

Zika virus (IB H 30656) 3.3 × 107 copies/mL Negative 
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Procedural Limitations 

The PANDAA Ebola kit is released for Research Use Only (RUO) and is not intended for use in diagnostic 
procedures. The assay is intended for use by lab personnel trained in the PANDAA Ebola assay 
procedure and in the operation of nucleic acid extraction and real-time PCR systems used on site. Good 
laboratory practices and adherence to the Instructions for Use are required to minimize contamination 
and ensure reliable assay performance . 

This assay has been evaluated for use with EDTA plasma specimens. Analytical performance with EDTA 
plasma does not establish clinical diagnostic performance or clinical utility. Use of specimen types other 

than EDTA plasma has not been established and may yield inaccurate or uninterpretable results. 

A negative result does not exclude the possibility that ebolavirus RNA may be absent from the sample, 

below the assay detection limit, or affected by specimen quality, handling, storage, transport, extraction 
efficiency, or amplification interference. The Internal Control and Sample Adequacy Control are included 
in PANDAA Ebola to help identify specimens containing substances that may interfere with nucleic acid 
isolation and PCR amplification. These controls do not eliminate the possibility of interference or other 
causes of invalid or non-representative results.  
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General Guidelines 

Shipping, Storage and Handling  

PANDAA Ebola is shipped on dry ice, and kit components arrive frozen. Store all components at −15 °C 

to −25 °C upon receipt, protected from light. Stop-Start RT enzyme contains glycerol and may remain 

liquid at −15 °C to −25 °C. Keep reagents in the original packaging when not in use and return them 
promptly to recommended storage conditions.  

Inspect all kit components upon receipt. Do not use reagents if they appear compromised (e.g., cracked 
or leaking vials, illegible labels, or evidence of thawing. If a temperature excursion, shipping damage, or 
a discrepancy between the kit labels and this IFU is suspected, quarantine the kit and contact Technical 

Support (support@aldatubio.com) before use. 

Ensure all reagents are fully thawed and mixed before use. Keep Stop-Start RT enzyme on ice during 
handling. Perform the PANDAA Ebola assay in environmental conditions at 20 °C to 25 °C and 30% to 
70% relative humidity.  

 

Real-time PCR Best Practices 

Since real-time PCR is a sensitive technique and the dynamic range of this assay extends to a very low 
template copy number, it is critical to perform accurate liquid handling to produce reliable results, and 
precaution must be taken when executing this protocol.  

 Handle reagents and RNA templates at separate / dedicated laboratory areas to prevent cross 
contamination.  

 Always ensure reagents and samples are fully thawed, thoroughly mixed and spun/centrifuged 
briefly before use.  

 Enzymes (Stop-Start RT enzyme and PRxB III buffer) and thawed viral RNA should be kept on 
ice while being used. 

 Ensure that a new pipette tip is used for each step in the protocol. Cross contamination between 
the samples and controls will affect the accuracy of the results.  

 Good laboratory practice should be observed at all times to avoid contamination of reagents, 
samples, consumables, pipettes, and work areas. 
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Safety  

Handle all specimens, extracted nucleic acids, and used consumables as potentially infectious and in 

accordance with applicable institutional biosafety procedures and local regulations. Wear appropriate 
personal protective equipment (PPE) (e.g., gloves, lab coat, and eye protection) and perform work in 
facilities suitable for molecular testing. 

To minimize contamination risk, follow good molecular biology practices, including physical separation 
of pre-amplification and post-amplification areas, use of aerosol-resistant pipette tips, and routine 
decontamination of work surfaces and equipment. Dispose of waste according to institutional 
procedures and local regulations. 

Chemical hazards associated with extraction reagents are specific to the extraction method used; follow 
the extraction kit manufacturer’s IFU and Safety Data Sheets (SDS). 
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Appendix A: Materials Required but Not Included  

All Workflows 

The following materials are required for nucleic acid extraction (if performed by the user) and for real-
time PCR setup and run on a compatible instrument. 

 

Category Components, Materials, or Reagents 

Personal protective equipment  Appropriate PPE (e.g., gloves, lab coat, eye protection) per 
institutional requirements. 

Liquid handling  Calibrated pipettes capable of dispensing 1 µL to 1000 µL 

 Aerosol-resistant (filter) pipette tips 

Consumables  RNase-free microcentrifuge tubes (for sample extraction and/or 
aliquoting) 

 Real-time PCR instrument consumables appropriate to the 
platform (e.g., plates or tubes/strips, optical seals/caps) 

Mixing and centrifugation  Vortex 

 Plate spinner / plate centrifuge (for brief spin-down of PCR 
plates, if using plate format) 

 Benchtop microcentrifuge (for brief spin-down of tubes/strips, as 
applicable) 

Temperature control and storage  Cold block or ice 

 Refrigerator, 2 °C to 8 °C (for short-term storage, as applicable) 

 Laboratory freezer, −15 °C to −25 °C (for kit storage) 
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Appendix B: Real-time PCR Instrument Setup and Analysis 

 ABI / Thermo Fisher: ABI 7500 / 7500 Fast *, QuantStudio 5 *, QuantStudio 6 Flex/Pro †, 

QuantStudio 7 Flex/Pro †, QuantStudio 12K Flex †, and ViiA 7. † 

 Qiagen: Rotor-Gene Q5/6 Plex * 

 Bio Molecular Systems: Mic * 

 Roche: LightCycler 96 †, LightCycler 480 II † 

 Bio-Rad: CFX96 † 

* Validated instruments.  

† Compatible real-time PCR instruments that have not been validated with PANDAA Ebola by Aldatu Biosciences. 

 

 ❚❛❜ 
CAUTION 

Ensure that your real-time PCR instrument has been installed, calibrated, and 
maintained according to the manufacturer’s instructions and recommendations. 

 

Use the real-time PCR run template provided by Aldatu Biosciences, available at www.aldatu.bio/qpcr-
templates. If your real-time PCR instrument is not listed then contact Technical Support 
(support@aldatubio.com) about your real-time PCR instrument requirements and configuration, and to 
obtain a run template file with the correct cycling conditions.  

Instrument Instructions 

Instrument Page 

ABI / Thermo Fisher Page 29 

CFX96 (Bio-Rad) Page 30 

LightCycler 96 and LightCycler 480 II (Roche) Page 32 

Mic (Bio Molecular Systems) Page 34 

Rotor-Gene Q (Qiagen) Page 36 
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ABI / Thermo Fisher 

Instruments: ABI 7500 / 7500 Fast, QuantStudio 5, QuantStudio 6 Flex/Pro, QuantStudio 7 Flex/Pro, 

QuantStudio 12K Flex, and ViiA 7. Templates (file extension .edt) provided by Aldatu Biosciences can 
be downloaded from www.aldatu.bio/qpcr-templates. 

Target Name Channel Reporter Quencher 

Ebolavirus (PAN EBOV) Blue FAM NFQ-MGB 

Internal Control (IC) Red Cy5 NFQ-MGB 

Sample Adequacy Control (SAC) Yellow TAMRA NFQ-MGB 

ABI / Thermo Fisher Data Analysis 

Template files provided by Aldatu Biosciences are programmed with the analysis settings below.  

Target Name Threshold Baseline 

Ebolavirus (PAN EBOV) 0.05 Auto 

Internal Control (IC) 0.05 Auto 

Sample Adequacy Control (SAC) 0.05 Auto 

1. Adjust threshold (PAN EBOV): Adjust the threshold for the PAN EBOV target so that the mean Ct 
of the Positive Control (PC) replicates is ~19 cycles (target range: 18 – 20 cycles). 

2. Analyze: Ensure that data are reanalyzed after any threshold adjustments.  

3. Save: Ensure that the analyzed .eds file is saved. 

4. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 

either the .eds run file or an exported Excel file. 

Using the .eds File Using the Exported Excel File 

Import the analyzed .eds file directly into the 
PANDAA VHF Interpretation Software. 

Export settings: From the Export menu, ensure 
that, at a minimum, the following content is selected 
for export. 

 Results 

 Amplification Data 

 Multicomponent Data 

Export: From the Export menu, choose *.xls or *.xlsx 
as the File Type and then export all data to one file. 
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CFX96 (Bio-Rad) 

Two separate template files are required for the CFX96, and can be downloaded from 

www.aldatu.bio/qpcr-templates: 

1. Protocol file: PANDAA Ebola - Cycling Conditions - CFX96.prcl 

2. Plate file: PANDAA Ebola - Plate Template - CFX96.pltd 

Using the .prcl Protocol File and .pltd Plate File 

1. Import protocol file: After starting a new user-defined run, import the .prcl template cycling 
conditions using Select Existing under the Protocol tab. 

2. Import plate file: Under the Plate tab, import the .pltd plate template containing the assay targets 
using Select Existing. 

Target Name Channel Fluorophore 

Ebolavirus (PAN EBOV) 1 FAM 

Internal Control (IC) 4 Cy5 

Sample Adequacy Control (SAC) 2 Cal Orange 560 

CFX96 Data Analysis 

1. Show amplification cycles: After the run is completed, select the Step Number dropdown in the 
Data Analysis window and select 8 to show the data collected during the amplification cycles. 

2. Adjust settings: Under the Settings menu ensure that the following settings are selected: 

a. Cq Determination Mode ► Single Threshold 

b. Baseline Setting ► Baseline Subtracted Curve Fit 

c. Analysis Mode ► Target 

3. Adjust threshold (PAN EBOV): Adjust the threshold for the PAN EBOV target so that the mean Ct 
of the Positive Control (PC) replicates is ~19 cycles (target range: 18 – 20 cycles). 

4. Fluorescence cutoff: Under the End Point tab, edit the following settings for the PAN EBOV target: 

a. End Cycles to Average: 5 

b. Percent of Range: 2.0 

c. Record any wells that are not called (+) Positive by endpoint RFU. 
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5. Analyze and save: Ensure that data are reanalyzed after any adjustments and save the .pcrd file. 

6. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .pcrd run file or an exported Excel file. 

Using the .pcrd File Using the Exported Excel File 

Import the analyzed .pcrd file directly into the 
PANDAA VHF Interpretation Software. 

Export settings: From the Export menu, select 
Custom Export. 

 Choose Excel 2007 (*.xlsx) as the Export 
Format 

 Select all options for Sample Description and 
Quantification. Ensure that End RFU is 
selected as an export column. 
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LightCycler 96 and LightCycler 480 II (Roche) 

Instruments: A template file for the LightCycler 96 or LightCycler 480 II can be downloaded from 

www.aldatu.bio/qpcr-templates.  

Detection format: Hydrolysis probes. 

Target Name Channel Dye 

Ebolavirus (PAN EBOV) 1 FAM 

Internal Control (IC) 4 Cy5 

Sample Adequacy Control (SAC) 2 Yellow555 

LightCycler 96 Data Analysis 

It is not possible to save analysis settings in the .lc96 template file provided by Aldatu Biosciences.  

1. Adjust threshold (PAN EBOV): Adjust the threshold for the PAN EBOV target so that the mean Ct 

of the Positive Control (PC) replicates is ~19 cycles (target range: 18 – 20 cycles). 

2. Adjust thresholds (IC and SAC): Place the IC and SAC thresholds in the exponential (log-linear) 

region above baseline and below plateau; apply the same setting to all samples and controls. 

3. Save: Ensure that the analyzed .lc96 run file is saved. 

4. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 

either the .lc96 run file or an exported text file. 

Using the .lc96 File Using the Exported Excel File 

Import the analyzed .lc96 file directly into the 
PANDAA VHF Interpretation Software. 

Ensure that the endpoint fluorescence (EPF) column 
is visible in the Results Table before exporting. If the 
EPF column is hidden, right click on the Results 
Table column headings ► Column Selector ► EPF 

Export: Right click on the Results Table ► Export to 
File ► Save as file type Text files (*.txt). 
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LightCycler 480 II Data Analysis 

Color compensation (multiplex): Apply an appropriate Color Compensation (CC) setting/object for 

multicolor assays before analysis. 

LightCycler 480 software reports the crossing point as Cp, which is treated as equivalent to Ct for 
reporting. To obtain Ct-equivalent values using a threshold-based method, use Absolute Quantification 
– Fit Points (threshold line method). 

1. Select analysis method: In the analysis modules, select Absolute Quantification ► Fit Points. (Fit 
Points uses a threshold line approach.)  

a. Select Analysis ► Abs Quant/2nd Derivative Max 

b. Under Method, select Fit Points (threshold line method) 

2. Adjust threshold (PAN EBOV): Adjust the threshold for the PAN EBOV target so that the mean 
Cp (Ct-equivalent) of the Positive Control (PC) replicates is ~19 cycles (target range: 18 – 20 
cycles).  

3. Save: Ensure that the analyzed .ixo run file is saved (.ixo is a supported export format on LC480). 

4. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .ixo run file or an exported text file. 

Using the .ixo File Using the Exported Excel File 

Import the analyzed .ixo file directly into the PANDAA 
VHF Interpretation Software. 

Export: Ensure that the endpoint fluorescence (EPF) 
column is visible in the Results Table. 

Right click on the Results Table ►Export to File ► 
Save as file type Text files (*.txt). 
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Mic (Bio Molecular Systems) 

The Mic Real-Time qPCR Cycler (Mic) from Bio Molecular Systems uses either an Assay definition file 

(file extension .micassay) containing cycling conditions, assay targets, and analysis settings, or a 
Template definition file (file extension .mictemplate), which additionally contains sample information. 
Templates provided by Aldatu Biosciences can be downloaded from www.aldatu.bio/qpcr-templates. 

1. Assay file: PANDAA Ebola.micassay 

2. Template file: PANDAA Ebola.mictemplate 

Target Name Channel Reporter Dye 

Ebolavirus (PAN EBOV) Green FAM 

Internal Control (IC) Red Cy5 

Sample Adequacy Control (SAC) Yellow NED 

Storing the Assay and Template Definition Files 

The .micassay and/or .mictemplate must be saved in the local user document folder on your PC e.g., 
C:\Users\username\Documents\Bio Molecular Systems\micPCR\Templates. This folder should have 
been automatically created when installing the micPCR software. If this folder is missing, contact Aldatu 
Technical Support (support@aldatubio.com). 

Using the .micassay Assay Definition File 

In the micPCR software select Run from the New menu. In the new run file, click on the + icon next to 

Assays on the left-hand bar. PANDAA Ebola can be selected from My Assays. If it is not visible then 
select Browse. Locate and select the PANDAA Ebola.micassay file, which will now be loaded into your 
new run. 

Using the .mictemplate Template Definition File 

The PANDAA Ebola.mictemplate contains the same cycling conditions, assay targets, and analysis 
settings as the .micassay file. It is also pre-loaded with the Negative Control in sample position 1 and 
the Positive Control in sample position 48.  

Select Run from Template from the New menu in the micPCR software. Choose PANDAA Ebola and 
click OK. If PANDAA Ebola is not visible in the list of templates, confirm that it has been stored in the 

correct folder on your computer. Alternatively, start a new run using the .micassay file. 
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Mic Data Analysis  

Template files provided by Aldatu Biosciences are programmed with the analysis settings below.  

Target Name Method Exclusion Cutoff Threshold 

Ebolavirus (PAN EBOV) Dynamic Simple N/A Auto 

Internal Control (IC) Dynamic None N/A Auto 

Sample Adequacy Control (SAC) Dynamic None N/A Auto 

1. Adjust threshold: Adjust the threshold for the PAN EBOV target so that the mean Ct of the Positive 
Control (PC) replicates is ~19 cycles (target range: 18 – 20 cycles). 

2. Save: Ensure that the analyzed .micrun file is saved. 

3. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .micrun run file or an exported Excel file. 

Using the .micrun File Using the Exported Excel File 

Import the analyzed .micrun file directly into the 
PANDAA VHF Interpretation Software. 

Export: From the Save As menu, select Excel 
Workbook and save the exported .xlsx file. 
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Rotor-Gene Q (Qiagen) 

The Rotor-Gene Q uses template files with the file extension .ret. Start a new run in the Rotor-Gene Q 
software by selecting New ► Open a template in another folder, and select the PANDAA Ebola - RGQ 
Template.ret file. The template file provided by Aldatu Biosciences contains the assay cycling 
conditions, targets, and gain settings and can be downloaded from www.aldatu.bio/qpcr-templates. 

Target Name Channel Source Detector 

Ebolavirus (PAN EBOV) Green 470nm 510nm 

Internal Control (IC) Red 625nm 660nm 

Sample Adequacy Control (SAC) Yellow 530nm 555nm 

Gain and Auto-Gain Settings 

Auto-gain optimization is performed before the 1st acquisition. The Rotor-Gene Q template provided by 

Aldatu Biosciences, PANDAA Ebola - RGQ Template.ret, is pre-programmed with this setting. Do not 
perform gain optimization at 60 °C at the beginning of the run. 

Rotor-Gene Q Data Analysis 

1. Set global analysis settings for all three assay targets: 

 Dynamic Tube and Slope Correct should be selected for consistent results across all runs. 

2. Set normalization options (PAN EBOV): In the analysis window for the PAN EBOV target, Outlier 
Removal should be set at 2% for the Ebolavirus (PAN EBOV) target. 

3. Adjust threshold (PAN EBOV): Adjust the threshold for the PAN EBOV target so that the mean Ct 
of the Positive Control (PC) replicates is ~19 cycles (target range: 18 – 20 cycles). 

4. Adjust thresholds (IC and SAC): Place the IC and SAC thresholds in the exponential (log-linear) 
region above baseline and below plateau; apply the same setting to all samples and controls. 

5. Save: Ensure that the analyzed .rex file is saved. 

6. Analysis: Proceed to data analysis with the PANDAA VHF Interpretation Software (page 14) using 
either the .rex run file or an exported Excel file. 

Using the .rex File Using the Exported Excel File 

Import the analyzed .rex file directly into the 
PANDAA VHF Interpretation Software. 

Export: Select File ►Save As ► Excel Analysis 
Sheet and save the .csv file. 
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Customer and Technical Support 

Email: support@aldatubio.com 

Address: Aldatu Biosciences  
313 Pleasant Street 
Watertown, MA 02472 
USA 

 

Disclaimers 

This kit is for Research Use Only and is not intended for use in diagnostic procedures. 

Aldatu Biosciences will not be liable for any direct, indirect, consequential or incidental damage related 

to or arising from the use, the results of use of this product or document. This User Guide Document is 
provided “as is” and is subject to being changed, without notice, in future editions. Aldatu Biosciences 
does not guarantee in any way that you will obtain satisfactory results from using this product as 
described herein. The only warranty provided is limited product warranty, that is, if this product does 
not meet the standard performance for control samples, the product will be replaced at no charge. 

 

Trademarks 

PANDAA® is a registered trademark of Aldatu Biosciences, Inc. PANDAA EBOV, PANDAA Ebola, and 
the Aldatu Biosciences logo are trademarks of Aldatu Biosciences, Inc. FAM® and ROX® are 
trademarks of Life Technologies Corporation. ABI Prism® (Applied Biosystems); CFX96® (Bio-Rad); 

Cy® (GE Healthcare); LightCycler® (Roche); Rotor- Gene®. All other trademarks that appear in this 
document are the property of their respective owners. 

 

Patents 

The PANDAA technology is covered by US Patent No. 10,100,349 and European Patent Application 
No. 3052656 owned by the President and Fellows of Harvard College and exclusively licensed to Aldatu 
Biosciences, Inc. 

 

 

Copyright 

© 2026 Aldatu Biosciences, Inc. 
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Explanation of Symbols 

 
For Research Use Only 

 
Catalog number 

 
Batch number 

 

Storage temperature range 

 
Use-by date 

 

Contents sufficient for n reactions 

 

Consult Instructions for Use 

 
Contents of the PANDAA® Ebola kit 

 

Manufacturer 
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